Faculty of Engineering, Design & Construction
Departments – Engineering (Civil & Mechanical) and Sustainable Design

Image Ray Georgiou 3D View, Visual Style Consistent Colours, Shadows On

REVIT BEGINNERS
BOOKLET D
Revit Architecture 2016

Student Name: ____________________
Note: This booklet revises the following aspects covered in booklet C

Grids
Floor slabs
Slab Edge
Foundation Walls
Footings

These are important basic structural components of building so they are reinforced in this booklet. This book extends into more detail on schedules and multiple A1 plot output.
Contents

REVIT BEGINNERS BOOKLET D ................................................................. 1

Revit Architecture 2016 ........................................................................... 1

Contents .................................................................................................. 3

Structure of Booklet D ............................................................................ 4

Contents and Structure ........................................................................... 4

Paste updated Grids from the simplified model ...................................... 5

Updating Grids ....................................................................................... 5

Copy and Paste ...................................................................................... 5

Using Tag on Placement ......................................................................... 10

Adding columns with the At Grids option .............................................. 11

Adding a Rebar Shape family ................................................................. 12

Rotate Columns in Foyer ......................................................................... 16

Creating a Column Schedule ................................................................. 17

Format to calculate totals ..................................................................... 18

Booklet D Part 2 ..................................................................................... 19

Establish a Floor 175 in situ concrete ................................................... 20

Floor Slab Edge ..................................................................................... 22

Foundation wall .................................................................................... 24

Establish Column footings .................................................................... 25

Roof slab ............................................................................................... 27

Copy Ground floor Windows and Walls to Level 1 ............................... 28

Grids for colonnade on the veranda ....................................................... 31

Pitched Roof ......................................................................................... 32

Timber Framing ..................................................................................... 34
Structure of Booklet D

Booklet D asks you to import some of the improvements made in Booklet C on a simplified version of your project. This a simple method of updating a project with a consultant’s input, for example updates could be from a structural engineer. So the simplified version is what you have at the end of Book C, it may be called Project_SIMPLIFIEDBOOKC_Final.rvt you will be asked to copy from this to the detailed project you have saved at the end of Book B, it may be called Project_ONE_BOOKB_Final.rvt You may prefer to add your initials/name to the end of these filenames to make identification easier. This file is your starting point for Booklet D. You will replace the grids with those from the project created in Booklet C Project_SIMPLIFIEDBOOKC_Final.rvt

Contents and Structure
Now that you are experienced with the Revit interface, it’s time to get more serious.

**Paste updated Grids from the simplified model**

- Open the simplified project file which you created by the end of Booklet C the file name in these notes is `Project_ONE_BOOKCFIN16.rvt`. Your filename may differ.
- Open your more detailed project, `Project_ONE_BOOKB_FinalV16.rvt` or similar filename of your own, saved at the end of book B. If your files are not roughly equivalent to those above contact your instructor to discuss your options.

**Updating Grids**

- In the Book B detailed project delete the grid lines that are visible in the Ground floor view below. All but Grids have been excluded from selection

**Copy and Paste**

- Select all the Grid lines using the Ctrl key to Add to selection, include this one corner column

- Click on Copy to Clipboard icon
• Use the View tab and Switch Windows icon to switch back to your detailed project, Project_ONE_BOOKB_FinalV16.rvt.

• In your detailed project click on any model item to bring up modify tab, then select Paste from Clipboard drop down.

• Click on Align to Current View

Note in practice the Grids will align with the current view because the simplified project is derived from the one original model project file.
In your work there may be a misalignment similar to that shown below, the corner of 450x450 column copied at the intersection of Grids zero(0) and A can be used to snap into the inside North West corner of the ground floor walls, to restore alignment.

- To align click on the move icon and hover over the top left corner of column A0 until a purple end point snap appears
- Hover on inside corner of the ground floor walls, until an endpoint snap appears and click to finalise alignment.

In screen captures where window tags are visible, ignore these for now.
Now you will have the Grid system from the simpler model within the detailed model. However, you may need to edit the vertical Grid line Bubble numbers to be ascending order left to right, and the horizontal Grid line letters in descending order from A.

- Edit vertical Grid lines 0 to 4. Horizontals in descending order starting with A

In Part B Booklet you were asked to place a number of columns, remove all of these
• Remember from Booklet C, choose Structural column. Make sure you choose Concrete-Square Column 450 x 450mm. If this family is not loaded in your project, use Load Family icon and source this family from the International Metric Library, Structural folder of your Revit LIBRARY DVD or REVIT LIB folder.

• Pick Tag on Placement, which we did not use in Booklet C

This alert comes up. Select Yes this initiates a Load Family command

• Select Annotations
• Double click on Tags

• Double click on Structural

• Select Tag Family, **Structural Column Tag - 45° (AUS).rfa**

A column midpoint can be placed at every Grid line intersection.

**Using Tag on Placement**

• Make sure to select Level 3 from this drop down and set this drop down to Height not Depth and Rotate after placement On.
Adding columns with the At Grids option

- Select At Grids

- Select all the Grid lines, in the Eastern part, of the building, here a crossing selection box is used, shown in dotted outline

- Finalise the selection box by releasing the left mouse button. The proposed Columns and their Tags are *previewed* automatically.

- Finalise the Column placement click on the Green Finish tick, hit Esc key.
So now there is a complete population of columns and Tags. Column A0 matches inside faces of North West corner.

- Column D-6 is in the lift well so Delete it
- Select the curved wall
- Check Centre Mark Visibility in the instance properties.
- Click on any column and select Rebar

Adding a Rebar Shape family
• Click OK in response to this message

• Click Yes to invitation to load Reinforcing bar shape family.

You will have to navigate to the Structural library folder or obtain access by USB

• Scroll down to Structural and Double click on Structural

• Select Rebar Shapes and Open SH.rfa
• Click on the Rebar Shape Browser

• With the Rebar browser open the hook shape horizontal steel can be rotated by gentle slight mouse movement.

• Use the View tab to create a section through the column and then activate the column and the Rebar Shape browser. The column is visible along its total height. By gently moving the mouse you can populate the column with several longitudinal bars.
Switch to **from parallel to work plane to Perpendicular** to Cover placement and in this example hook iron is placed at intervals down the column. So a "cage" of reinforcing is built up within this column. For the purpose of illustration floors and some walls were temporarily hidden from view or visibility.

Specialists in steel fixing will find it easier to work with views set to the Structural Discipline. Where there are intersecting load bearing structural elements the rebar panel will allow a designer to place intersecting bars.

This is the subject of a separate series of booklets under development for reinforced concrete.
Rotate Columns in Foyer

**Rotate columns** CH and EH so they become radial in orientation

- Click on either column, select Rotate

  ![Column Rotation Diagram]

- Establish your start axis say vertically downwards and swing it around until you snap to radial wall centre.

  ![Column Rotation Diagram]

Repeat procedure for column EH. Check what you have in the 3D default view.
Creating a Column Schedule

- Click on the View tab, Create panel pick Schedule/Quantities

- Scroll down to Structural Columns and select Existing from the Phase drop down and click OK

Here the Fields of interest are selected. Remember Revit is a gigantic dynamic 3D database, so why would you design a virtual 3D building in computer space if you don’t take off material quantities and costs?

- Select these fields one at a time and click Add
• Activate the Sorting/Grouping folder.

[Image of the Schedule Properties dialog box with fields sorted by Column Location Mark with ascending order]

• Set the folder as above

[Image of the Schedule Properties dialog box with the formatting for calculating totals]

Format to calculate totals
• Select the Formatting folder and pick Cost and check Calculate Totals

[Image of the Schedule Properties dialog box with the formatting for calculating totals]

• Do the same for Volume

Your Structural Column Schedule should look similar as shown below:
Instructions for Booklet D part 2

The changes below differ from those in Booklet C

1. Column positioning and detail
2. Establish a Floor 175 in situ concrete instead of 225mm thick used in Booklet C. Place footings using isolated foundations and load the family from the International Metric library, set pads for the columns 900x900x600. You need to make a duplicate of one of the default sizes.
3. Change the Foundation Wall to 2200mm depth
4. Use Copy/Paste, refer to pages 3-4 in Booklet C, to copy and paste ground floor rooms to Levels 1 and 2.
5. Compose an A1 sheet containing Plan View and section DD. Send the A1 sheet to the large format plotter at 1:100 scale. Remember to add your name onto the Titleblock. Make a second sheet for the Door schedule, Column Schedule, Room Schedule and Drawing Schedule. Plot a third A1 sheet for the Corridor section, section through women's WC and a default 3D view

Based on the 3D information modelling features you have used so far, what value can Revit offer you in your current field in which you practise? Answer this question on the task sheets
Establish a Floor 175 in situ concrete

- Select Floor Structural from the Build panel.

- Click on Edit Type because a Duplicate floor size is required.

- Select Duplicate and enter the new name, Generic 175mm.
• Click on Edit because it is necessary to change the size to match the name.

• Uncheck Extend into wall (to core)

• Hover along this wall and gently tap the Tab key and a blue closed boundary will generate around the ground level.
- Click the left button of the mouse

The boundary turns magenta. Note that the boundary is also visible on the 3D view if you tile the views by typing WT.

- Finalise the floor by clicking on Finish Edit Mode

The floor slab is finalised.

Floor Slab Edge
Add a different size slab edge to that used in Booklet C.

1. Add in a slab edge size 900 x 450
• Click on Floor icon in the build panel and select Slab Edge

Now you have done this with 900 x 300 Slab Edge on page 18 in booklet C on the simplified model.

• Click on Edit Type. This time choose Profile 900 x 450 Edge thickening

• Now activate your 3D Default view and use the shift key + thumb wheel combination to orbit the building so the underside is visible

• Type WT which tiles the views.

• As you place the Slab Edge on the Plan View, it is filling in on the 3D view on the underside of the building!
Add a **Foundation wall** as previously done on pages 19 – 24 in Booklet C; but this time we vary the parameters. The thickness will be 600mm instead of 700 and set the Base Offset to -2500mm. Begin with Architecture tab, Wall and Structural Wall

- Type WT to tile your views. One view is the 3D underside of Ground Floor

The other tile is the Ground Floor. This technique allows you to see the foundation wall growing as you pick your way along the exterior face of the exterior walls. You should arrive at the position below. The Foundation Wall has been named FOUNDATION 600mm
Establish Column footings

- Click on Structure tab and pick Isolated, from the Foundation tab.

- Select Yes and browse to Structural in the International Metric Library

- Pick the family, M_Footing-Rectangular

- Use Edit Type and the Duplicate option to create a 900x900x1000 footing
- Select the At Columns icon

- Then you can use a whole selection box and select only columns inside the outer walls which are adequately supported by the foundation wall.

- Quite conveniently if you tile a 3D Ground Floor underside View, a preview where you are heading shows in the 3D View.

- If the footings are correct Click on the Finish icon
It's time to fill in the main wing of the building with Roof slab

1. Roof slab, because we have a terrace roof
2. Copy ground floor rooms and windows to Level 1
3. Copy ground floor rooms and windows to Level 2

For the roof use General Concrete Floor 175mm thickness

- Remember to make sure Extend to wall core is unchecked, hover on a Level 3 wall and gently tap the Tab key and confirm the boundary. Note if you tile a 3D view the magenta preview lines show up there as well.
• Once you have a complete magenta line loop confirm the green tick

The roof slab will be generated in a blue colour. Once you click the mouse or press Esc twice the slab will turn grey, if Visual Style is set to Shaded or Consistent colours

Copy Ground floor Windows and Walls to Level 1
Use a crossing box to preselect the contents of the ground floor and pick Filter

• In the Filter dialogue uncheck most items except windows, text, walls and doors and click OK
• Holding the shift key down remove the external and lift well walls from the blue selection set.
• Click on Copy to clipboard
• Activate Level 1 View, select Paste from Clipboard
• Then pick Aligned to Current View
The internal walls and windows are completed on level 1

Do the same process for level 2 on your own.
  
  - You will need to create additional Grid lines at 20° intervals to establish the positioning of the veranda columns in Revit Level 1 course, Grid 7 shown here

When the other 7 Grids are in position, one for each porch column, the plan view looks as below:
Grids for colonnade on the veranda
These are used in Booklet E, Revit Level 1 course.

- Switch to Default 3D View and select the outermost circular wall
  - In the wall properties set Base Offset to 8825 and Unconnected height to 675.0
- Switch to the Ground Floor and tile your views by typing WT

The inner circular wall which will become a curtain wall in Booklet E is now visible.
- In the Plan view select the remaining external walls and raise the Unconnected Height to 9500
Result is that all external walls are now a consistent height of 9500. They form a parapet around the concrete slab roof.

- Pick the column at grid HD and use Move to move it to H11

**Pitched Roof**

- Pan across to the cafeteria end of the ground floor.
• Double click on Level 2
• Select the Roof drop down and pick Roof by Footprint. The default is no eave overhang and 30° pitch roof slope.

See if you can define a closed loop of magenta lines using a Line for this part of the loop and pick walls for the rest of the loop. It should make a loop visible in 2D and 3D views. The aim is to make a continuous loop with no gaps.

Once the closed loop is complete, confirm with the Green tick
• Wow! A complete pitched roof is generated

• In this case you can answer No. The level 2 view shows where the clip plane goes through the roof.

• Open the Extensions tab.

• From the Basic Roof drop down select Generic 125mm.
- From the Modeling drop down select Rafter Framing

The Revit Timber Framing productivity tool generates a complete roof analysis for the Rafters, Hips/Valleys, Ridges, Collars and Purlins.

- The Rafter parameters cover section size and spacing between centres, select OK
Revit calculates the members, note that they can be individually accessed and re-sized if required.

You may experiment with an existing block wall with windows to check what Wood Framing Walls will do.

PTO

For reference and trial